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Where to Find Help When You Need It 

 
Help from your Division/College’s Computer Consultant 
Some divisions and colleges have computer consultants assigned to them.  You can contact these 

consultants when you need help.  To determine if you have a consultant assigned to your division or 

college, look to: http://rohan.sdsu.edu/~facstaff 
 

Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative to provide all 

students, faculty, and staff with "baseline" access to information resources via networks, training in the 

uses of baseline hardware and software systems, and ongoing professional and technical support for 

utilization of computer resources at San Diego State University.  You can access the BATS Web Page 

by pointing your browser to: http://its.sdsu.edu/~bats/ 
 

Help in the San Diego State University, Faculty Room 
The Faculty Room is staffed Monday through Friday with computing consultants who will try to answer 

your questions.   

Location:    Adams Humanities, 1109 

Phone Number:   x45727 

Semester Hours:   7:30am – 6:00pm Monday -Thursday 

7:30am – 4:30pm Friday 

Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 
Help from the Faculty Computing Help Line 
Phone Number: x41348  E-mail: helpline@mail.sdsu.edu 

Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 

Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 

Help from the Staff Computing Help Line 
Phone Number: x40824  E-mail: staffhelp@sdsu.edu 

Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 

Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 

http://rohan.sdsu.edu/~facstaff
http://its.sdsu.edu/~bats/
mailto:helpline@mail.sdsu.edu
mailto:helpline@mail.sdsu.edu
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WORKSHEET 

TABS 
 

 
 

 

 

 

 

 

By default, when you open Excel you are presented with three 

worksheet tabs at the bottom of the window.  Each workbook 

contains 255 worksheets, and you can manipulate the worksheet tabs 

by right clicking on any tab. 

 

Insert… 

 

You can insert a new worksheet tab in your workbook. 

 

Delete 

 

If you choose delete, you will delete the active worksheet tab and all 

its contents. 

 

Rename 

 

Name or rename the worksheet tab. 

 

Move or Copy… 

 

This allows you to move the active worksheet to another workbook or 

to a different location in this workbook. 

 

View Code 

 

Takes you to the Visual Basic Editor. 

 

Protect Sheet… 

 

Allows you to apply protection to the worksheet. 

 

Tab Color 

 

Opens a pallet of colors from which you can select a color for the 

active tab. 

 

Hide 

 

Allows you to hide the current worksheet. 

 

Unhide 

 

Displays a window showing all hidden worksheets.  Chose the 

worksheet you want to unhide. 
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Select All Sheets 

 

Selects all the worksheets in the workbook. 

 

 

FORMULAS 
 

The Formula Bar 

In Excel, a formula always starts with the equal (=) sign. 

 

When the formula bar is active, you can create a formula by typing, 

inserting functions, or selecting cells. Simply click in the data entry 

area and begin typing. 

 

 
 

 

 

Types of Operators 

 

You use operators to specify the kind of mathematical operation to 

perform on the elements of a formula.  The common types of 

operators used in formulas are arithmetic operators and comparison 

operators. 

 

Arithmetic Operators 

 

These operators perform basic mathematical operations, combine 

numeric values and produce results. 

+ Addition 

– Subtraction 

/ Division 

* Multiplication 

% Percent 

^ Exponentiation 

 

Comparison Operators 
 

Compare two values and produce logical values of TRUE or FALSE 

with these operators. 

= Equal 

> Greater than 

< Less than 

>= Greater than or equal to 

<= Less than or equal to 

<> Not equal to 

 

 

 

 

Formula entry area 
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Order of Operations When Excel solves an expression it follows the rules of algebra.  An 

expression will be solved in the following order: 

 

Parenthesis [()] 

Exponential [x
2
] 

Multiplication [*] 

Division  [/] 

Addition  [+] 

Subtraction [-] 

 

Two helpful tools that will help you to remember the order of 

operations are: 

 

 PEMDAS (The first letter of each operation) 

 Please Excuse My Dear Aunt Sally 

 

 

What Formula Error 

Values Mean 

Microsoft Excel displays an error value in a cell when it cannot 

calculate the formula properly.  Error values always begin with a 

number sign (#). 

 

Error value Meaning       

#DIV/0! Is trying to divide by zero. 

#N/A Refers to a value that is not available. 

#NAME? Uses a name that Excel does not recognize. 

#NULL! Specifies an invalid intersection of two areas. 

#NUM! Uses a number incorrectly. 

#REF! Refers to a cell that is not valid. 

#VALUE! Uses an incorrect argument or operand. 

##### Produces a result that is too long to fit in the cell.  This 

is not actually an error value, but an indicator that the 

column needs to be wider. 

 

 

Copying Formulas Many times, you may want to copy the same formula across a number 

of columns or down a number of rows.   

 

To copy a formula to other columns: 

 

1. Select the cell of the formula you want to copy. 

 

2. Drag the fill handle (bottom right corner of the cell) across the cells 

in which you want to copy the formula. 
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Excel copies the formula to the other cells and, in each column adjusts 

the formula’s references so that the formula refers to the numbers in that 

column. 

 
 

To copy a formula to other rows: 

 

1. Select the cell of the formula you want to copy. 

 

2. Drag the fill handle (bottom right corner of the cell) down through 

the cells in which you want to copy the formula. 

 

 

RELATIVE CELL 

ADDRESSES 

When a cell address is used in a formula, it is generally input as a 

relative cell address. 

 

For instance, if the formula =A3*B3 was input into cell A1, the 

addresses of the cells referenced in the formula would be looked at as 

residing in locations relative to cell A1. 

 

Excel would read the formula as follows: 

 

Find a value in a cell that is located in the same column three rows 

down, (this would be A3) and multiply that value by a value that is 

located one column to the right and three rows down (this would be B3). 

 

 

 

ABSOLUTE CELL 

ADDRESSES 

Sometimes it’s helpful to use an absolute cell address instead of a 

relative cell address in a formula. 

 

When you use an absolute cell address in a formula, you are pointing 

Excel to a specific cell as opposed to pointing to a cell that is in a 

location relative to the cell in which the formula resides. 

A cell address of A1 is relative.  A cell address of $A$1 is absolute. 

 

You can use the F4 key to toggle through the naming convention 

options.  You can reference a cell as having a relative address (A1), an 

absolute address ($A$1) or a mixed address ($A1 or A$1). 

 

 

 



Microsoft Excel 2007 – Intermediate I 
 

 

Microsoft Excel 2007 – Intermediate I 5 

DISPLAY 

FORMULAS 

When you create a formula in a cell and press ENTER, the results of the 

formula displays in the cell and the formula displays in the Formula Bar. 

 

To display the formula in the cell, hold down the Ctrl key and press the 

tilde key.  This is a toggle that switches the way Excel displays formulas 

in cells. 

 

 

# N/A TOOL 

 

To avoid the problem of unintentionally including empty cells in your 

calculations use #NA to mark empty cells.  

 

Simply enter #N/A in an empty cell in the worksheet where the data is 

to go, and every cell that relies on that data will reflect the #N/A 

message. 

 

Formulas will not be over written, and you will know that some data is 

missing in your worksheet. 

 

COMMENTS To make a comment in a cell: 

 

1. Select the cell to contain the comment. 

 

2. Click on the Review tab, and in the Comments group click on New 

Comment. 

 

3. Type the text of your comment on the yellow note.  Click elsewhere 

on the worksheet.  A red triangle will appear in the upper right 

corner of the cell indicating that a comment is attached to the cell. 

 

4. To view the comment, position the mouse pointer over the cell. 

 

5. To delete the comment, click on the Review tab, and in the 

Comments group click on Delete. 

 

 

CONDITIONAL 

FORMATTING 
 

 

 

 

 

 

 

 

Microsoft refers to the power of Conditional Formatting as “Data 

Visualization”. 

 

With data visualization you can: 

 

 Add data bars to cells based on the cell values 

 

 Add color scales to cells based on the cell values 

 

 Add icon sets to the cells based on the cell values 
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 Identify duplicate values in a range of cells 

 

 Identify cells with values greater than the average of the range of 

cells 

 

 Identify cells with dates meeting your criteria 

 

 

To access conditional formatting: 

 

1. Select the desired range of cells. 

 

2. Click on the Home tab and then click on Conditional Formatting 

in the Styles group. 

 

3. A drop down menu will appear giving you the following options: 

 

Highlight Cell Rules 

 

You can use conditional formatting to find cells with values greater 

than, less than, equal to or between a value or values that you specify. 

 

You can also find cells containing dates within ranges you specify. 

 

You can find cells containing text you specify and you can find 

duplicate values and unique values. 

 

Top/Bottom Rules 

 

You can find cells with the largest values or smallest values and cells 

with values that exceed or are less than the average of the cells that are 

selected. 

 

Data Bars 

 

You can superimpose colored data bars in the cells with the longer bars 

representing the larger values and the smaller bars representing the 

smaller values. 

 

Color Scales 

 

Excel can fill the cells with a color scheme based on the values in the 

cells.  You pick the color for the highest value and the lowest value and 

Excel will fill the cells using a gradient of the two colors chosen. 
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Icon Sets 

 

Excel can automatically apply an icon to a cell based on the relative size 

of the value in the cell compared to other values in the range. 

 

 

 

 

LINKING 

WORKSHEETS AND 

WORKBOOKS 
 

 
 

When you open Excel, you are opening a Workbook that consists of a 

variety of Worksheets.  Each Worksheet contains a massive grid of rows 

and columns (1,048,576 rows and 16,384 columns), and each Workbook 

can contain from one to 255 Worksheets. 

 

Each Worksheet is assigned a default name such as Sheet1, Sheet2 etc., 

and the name can be easily changed to a more meaningful name by 

double clicking on the default name and typing in the new name.  

 

Linking Worksheets 

 

You can include a large amount of data on a Worksheet, but often it is 

hard to find information spread out over a single Worksheet.  Many 

users find it easier to work with multiple Worksheets, and they use 

Excel’s linking function to calculate values based on cells on other 

Worksheets. 

 

As an example, assume that you have a single Workbook with data in a 

Worksheet named SalesIncome and in a second Worksheet named 

InterestIncome.  You need to add the value of cell A7 on SalesIncome 

to cell B3 on SalesIncome with the result showing in cell F9 on a third 

Worksheet named TotalIncome. 

 

The formula you would type in cell F9 on the TotalIncome sheet would 

be: 

=SalesIncome!A7+InterestIncome!B3 

 

=  Tells Excel that this is a formula 

SalesIncome Refers to the sheet labeled SalesIncome 

! Simply separates the sheet reference from the cell 

 reference 

A7 Is the cell reference on SalesIncome 

+ Indicates the type of operation to be performed 

InterestIncome  Refers to the sheet labeled InterestIncome 

! Simply separates the sheet reference from the cell 

 reference 

B3 Is the cell reference on InterestIncome  
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Linking Workbooks 

 

Some people may elect to use multiple Workbooks in addition to 

multiple Worksheets, and Excel provides a means of linking 

Worksheets in multiple Workbooks in order to calculate formulas. 

 

As an example, assume that you have a Workbook named SalesData 

and another Workbook named BankReports. Each Workbook contains 

multiple Worksheets.   

 

Assume that you need to add the value of cell C3 in Worksheet 

UnionBank in Workbook BankReports to the value of cell G6 in 

Worksheet NorthSales in Workbook SalesData.  The result is to be 

shown in the Workbook BankReports in cell N8 on Worksheet Taxes. 

 

The formula you input into cell N8 would be: 

 

=[SalesData]NorthSales!G6+[BankReports]UnionBank!C3 

 

= Tells Excel that this is a formula 

[SalesData] A Workbook name 

NorthSales A Worksheet in the SalesData Workbook 

! Simply separates the sheet reference from the 

 cell reference 

G6 A cell in the NorthSales Worksheet 

+ Indicates the type of operation to be performed 

[BankReports] A Workbook name 

UnionBank A Worksheet in the BankReports Workbook 

! Simply separates the sheet reference from the 

 cell reference 

C3 A cell in the UnionBank Worksheet 

 

 

CHARTS 

 

 

 

 
 

To create a chart it’s best if you select the data to be charted first.  Then 

click on the Insert Tab and then click on the type of chart you want 

from the Charts group. 

 

Your chart will be created automatically and it will be placed in the 

active worksheet and it is automatically linked to the worksheet you 

created it from.  When you change the data on your worksheet, the chart 

is updated to reflect these changes. 
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Plotting Data Series in 

Rows or Columns 

When you create a chart, you specify the orientation of the data–whether 

the data series are in rows or columns that are adjacent to each other. 

 

Plotting Nonadjacent 

Selections 

However, sometimes the data you are plotting is in rows or columns 

separated by other data or by blank rows or columns.  You can make 

nonadjacent selections and use them to create a chart by: 

 

1. Selecting the cells in the first row or column 

 

2. Hold the CTRL key down while you make additional selections. 

 

Changing the Chart Type 

 

Sometimes you want to change the chart type to better illustrate you 

data. 

 

To change the chart type: 

 

1. Activate the chart by clicking on the chart image.   

 

2. Click on the Chart Tools – Design tab and then select Change 

Chart Type from the Type group. 

 

3. Select the type of chart you want from the Change Chart Type 

window. 

 

 

 

 

 

 

 

 

Adding Elements 

 

Adding items to a chart 

 

A simple chart cannot always convey information as clearly or 

completely as you would like.  You can add information, increase visual 

interest, and enhance readability by adding elements such as data labels, 

titles, a legend, and gridlines. 

 

To add additional elements to your chart, click on the Chart Tools – 

Layout tab.  Here you can pick and choose from a variety of items that 

can be added to your chart. 

 

 

FUNCTIONS 

 
 

 

Microsoft Excel comes with a variety of built in pre-defined functions 

for your use. 

 

Whenever you want to use a built-in Microsoft Excel function or a 

custom function, all you need to do is to assemble the arguments 

correctly, and insert the function into your formula.  The formula bar 

shows the changes you make as you build your formula. 
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To insert a function, click on the Formulas tab and the Functions group 

displays a variety of functions. 

 

The AutoSum button quickly shows you the most often used functions.  

The most common functions (Sum, Average, Count Numbers, Max and 

Min) will be listed and can be activated from the drop down list.  To 

find additional functions click on More Functions. 

 

 

FORMAT PAINTER 

 

 
 

 

Once you have a cell or range formatted the way you want it, you may 

decide that that formatting should be applied elsewhere on the 

spreadsheet. Instead of going through all the formatting steps again, use 

the Format Painter tool to copy the desired formatting to the other 

area(s). 

 

1. Select the cell or cells that contain the formatting you want to copy. 

 

2. To apply the formatting to one cell or range, click on the Home tab 

and in the Clipboard group click on Format Painter (the paint 

brush). To apply the formatting to multiple cells or ranges, double 

click on the Format Painter icon. 

 

3. Select the cell or cells that you want to format with the same 

options.  When you release the mouse button, the selected range 

will be formatted just like the original range. 

 

4. If you are formatting more than one cell or range, select the cells or 

ranges to be formatted and release the mouse button.  Continue this 

step until all desired cells or ranges are formatted. 

 

5. When you are done formatting multiple cells or ranges, click on the 

Format Painter icon once more to quit the Format Painter. 

 

CURRENT DATE 

AND TIME 

To enter the current date in a cell, press the Control and the Semicolon 

keys simultaneously. 

 

To enter the current time in a cell, press the Control and the Shift keys 

simultaneously then press the Colon key. 

 

 

FRACTIONS To enter a fraction, type the integer, then hit the space bar and type the 

fractional part. 
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To enter only the fractional part, type a space, and then the fractional 

part. 

 

 


